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Introduction 

Who Should read this guidance? 
This guidance is intended for individuals within Local Authority (LA) teams and associated 
Provider organisations who are responsible for administering the National Child 
Measurement Programme (NCMP) in their area. 

For security and Information Governance considerations, access to the NCMP IT system is 
restricted depending on your role within the programme. Therefore, you may not have user 
permissions to access some areas referred to in this guidance. 

How will this guidance help me? 
This guidance will show you how to feedback pupil measurements to parents. It will show 
you how to: 

• Filter pupil data to export child data that meets specific criteria. 

• Export pupil data in a CSV formatted file. 

• Perform a mail-merge using Microsoft Word. 

• Use advanced mail-merge features in Microsoft Word  

 

Available NCMP IT System Guidance 
 

1 Setting Up Schools List. 

2 Setting Up User Accounts 

3 Pupil Data Management 

4 Generating Feedback Letters 

5 Progress and Data Quality Monitoring  

6 Data Submission 

 

What is a Super User? 
Each LA will typically have one user who is responsible for the administration of the NCMP 
IT system. The super user can: 

• Add and remove users. 

• Assign user roles in accordance with Information Governance requirements. 

• Assign schools to users in accordance with Information Governance requirements. 
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Log in to the NCMP IT system 

Once you have a NHS Digital account, you can login to NCMP IT system. 

1. Open your web browser. 

2. Enter the following web address (URL) in the address bar at the top of the browser: 

 

3. This URL will take you to the Sign In screen.  

 
 

4. Click the Sign In link at the top right of the screen as shown above. 

Enter your username & password and click the Sign In button. 

 

  



Generating Feedback Letters 

Copyright © 2024, NHS England. All rights reserved. 5 
 

The parental feedback process 

Parental feedback allows Local Authorities to produce individual letters to parents of every child 
measured, advising parents of their child’s measurements and offering useful advice, including 
information about local services and contact numbers. 

The feedback process consists of four stages: 

1. (Optional) Apply filters to the Pupil Grid, to show only the pupils that meet specific criteria 
e.g. all pupils in Year 6 who have been measured. 

2. Identify and resolve warnings. 

3. Generate and export a CSV file containing pupil data. 

4. Use Microsoft Word to mail merge the exported NCMP child data with a letter template. The 
templates could either be those recommended by Office for Health Improvement and 
Disparities (OHID) or templates approved by your own LA. 

Apply filters 

You may want to send letters to parents whose children meet specific criteria e.g., all Year 6 pupils 
who have been measured and categorised as healthy. To extract this data, you must apply a filter 
to the Pupil Grid. 

1. From the NCMP Public Home page, click the Schools tab at the top of the page. 
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2. Click the   link for the school you want to extract data from. 

 

3. You can select criteria to apply to the pupil data, on the fields shown below. 

a. Year Reception (R) or Year 6 (6). 

b. Sex Male or Female. 

c. Ethnicity Select ethnicity code. 

d. BMI Category  Underweight, healthy weight, overweight or very 
overweight. 

e. Measured Measured or Not Measured 

f. Feedback Generated Generated or Not Generated 

g. Non Measure Reason   Absent, Child Opt Out, Parent Opt Out, Unable To 
Stand On Scales, No Longer At School, Awaiting 
Consent or Other 
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4. Once you have selected your criteria, click the  button.  

 

Identify & resolve warnings 

Data warnings are intended to bring missing data or abnormal measurement values that are not 
within expected ranges to your attention. Warnings are highlighted with an amber coloured border 

and a  symbol is placed next to each record that requires attention. 
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However, it may be the case that measured values are outside expected ranges, in which case you 
are given the option to suppress a specific warning for a specific value. Once suppressed, the 
warning will not appear again. 

 

A record will be highlighted with a warning if: 

• A child’s postcode is blank. 

• A child’s postcode is the same as the School’s postcode. 

• A child’s height, weight or BMI is outside the expected range. 

Example of data warnings 

  

  

 

 

  

 

 

The data that needs to be corrected or supressed could be on any of the five 
data tabs. 
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Generate and export a CSV file for letter generation 

Once all warnings have been resolved, the required data is ready to be downloaded to your local 
network:  

1. In the Schools page, click the   link for the school you want to extract data from. 

2. The pupil grid for the selected school is shown. 

  
 

3. After applying any filters (optional- see Apply filters on page 5 above), from the Pupil grid, 
click the Letter generation link under the Export Records heading. 
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4. If there are warnings on any pupil records selected for letter generation, a list of pupils and 
their associated data warnings will be displayed. Depending on the number of warnings, this 
may only be a partial list. 

 

 

5. Depending on your security settings, you may see a security warning at the top of the 
browser. Click the link Click here for options then click  Download file… 

 

  

 You will not be able to download any pupil data if any warnings are present 
within the selected data. 
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6. If there are no warnings, security or otherwise, the following dialog box is shown when the 
Letter generation link is clicked. 

 

7. Click   

 

8. Navigate to the folder where you want to save download file to. 

9. It is recommended to change the filename to reflect the downloaded data set depending on 
the filters you applied (if any).  
 
For example, if you applied a filter of ‘Healthy’ on the BMI Category field for Appletree 
Gardens First School, you may want to save the file with the name of 
PupilDataHealthyAppletree.csv. 

 

10. Click . 
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11. The downloaded file will be saved in the specified folder and each record included within the 
file will be flagged as having parental feedback generated with a symbol. 

 

12. To view the downloaded data, either: 

a. Open Windows Explorer and navigate to the downloaded file. Double click the file 
to open. 
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b. OR open Microsoft Excel. Click the File tab & select Open. Then, navigate and 
change the File type to  Text File.  

Select the downloaded file and click . 

 

 

The download file contains the following fields which will be used during the mail merge.  

 

 

Field Name Description 

FirstName Child’s First Name 

LastName Child’s Second Name 

NHSNumber Child’s NHS Number 

DateOfBirth Child’s Date of Birth 

DateOfMeasurement Date when Measurement Occurred 

Height Height Measurement  (in cm) 

Weight Weight Measurement in Kg 

PScore Percentile Score 

ClinicalBMICategory BMI category 

LA Local Authority 

Address1 Child Address Line 1 

Address2 Child Address Line 2 

Address3 Child Address Line 3 

Address4 Child Address Line 4 

Address5 Child Address Line 5 

Postcode Child’s Postcode 

ParentEmail Parent’s Email Address 

ParentTelephone Parent / guardian phone number 

SchoolUrn 6 digit unique school number 

SchoolName School name 

Sex Male or Female 
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The file should also look similar to the following. 
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Performing a mail merge with Microsoft Word. 

 

The Mail Merge feature in Microsoft Word enables you to create parental feedback letters en-mass 
by combining a standard template letter with the exported child data file. This means that each 
parent receives the same basic letter but each letter is personalised with their child’s measurement 
results.  

The process of creating feedback letters to parents requires a mail merge between the downloaded 
NCMP child data file and a letter template.  

 

Exported NCMP 
Child Data 

Personalised 
Parental 

Feedback Letters 

Letter Template 
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Feedback letter generation methods 

To generate feedback letters: 

1. (Recommended). Generate and export a single CSV file from the NCMP IT system, 
containing data of all pupils in all BMI categories in the selected school(s).  

You can then perform a single mail merge with a Microsoft Word template provided by NHS 
Digital. This mail merge template automatically adapts the text in the body of the feedback 
letter according to each child’s BMI Category.  The four different letter templates 
(underweight, healthy weight, overweight and very overweight) are to be found in Appendix 
A. 

 

2. Alternatively, your LA may have developed its own feedback templates or you may decide to 
modify the template provided by NHS Digital.  

 

 

NHS England feedback letter templates 

 
NHS England recommended feedback letter template is available on the main website (entitled 
NCMP results letter template.doc)  

 

Also available for download is a test pupil data CSV file (Example Pupil Feedback CSV File).  
This file should be used to setup the feedback letter templates to reflect your local settings before 
performing a mail merge.   

 

Save both of these files to a folder on your network. 

 

These templates can be downloaded to a folder on your network from: 
https://digital.nhs.uk/services/national-child-measurement-programme/it-system  

 

For details of the individual BMI category templates, please see OHID's Operational Guidance 
homepage. 

 

 
 

 

 

The benefits of using this method are: 

• A single mail merge covering all BMI categories to simplify the process.  

• Minimises the risk of parents receiving inaccurate feedback letters. 

 

 
When using this method, GREAT CARE must be exercised to ensure the 
correct BMI category CSV file is merged with the correct Microsoft Word 
template.  

 

 

If you are using an earlier version of MS word and are unable to open the feedback 
letter templates, you need to install the Microsoft Office Compatibility Pack. 

http://office.microsoft.com/en-gb/word-help/open-a-word-2010-document-in-an-
earlier-version-of-word-HA010370115.aspx 

 

https://digital.nhs.uk/services/national-child-measurement-programme/it-system
https://www.gov.uk/government/publications/national-child-measurement-programme-operational-guidance
https://www.gov.uk/government/publications/national-child-measurement-programme-operational-guidance
http://office.microsoft.com/en-gb/word-help/open-a-word-2010-document-in-an-earlier-version-of-word-HA010370115.aspx
http://office.microsoft.com/en-gb/word-help/open-a-word-2010-document-in-an-earlier-version-of-word-HA010370115.aspx
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Setting up the feedback letter template 

Before the template can be used in a live mail merge it must be set up for use within your LA. 

Open the feedback template (e.g. NCMP results letter template.docx) in Microsoft Word.  
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The letter consists of: 

• Static text – This text does not change 

• Mail merge fields – Microsoft Word replaces these merge fields with the data from the 
child data CSV file. These fields (First Name, Last Name etc.) are shown encapsulated 
within chevrons (<< >>) usually with a grey highlight. 

• Conditional text – Specific paragraphs are designed to be included in the feedback letter 
depending on the child’s BMI category. For example, the text included in a letter for a 
child in the Very overweight category to provide sources of helpful information, is not 
included in a feedback letter for a child in the Healthy weight category. Also, usually 
shown with a grey highlight. 

• LA specific text – This text has been formatted with a yellow highlight and is specific to 
each LA so requires modifying. It includes your LA’s contact details (address, telephone 
No.,) and other LA specific information.  

 

 

Link the template with the test pupil data CSV file. 

The test pupil data CSV file (PupilFeedback.csv) contains 4 records, one for each BMI category.  
You will need to temporarily link this file to the template in order to complete the template’s setup 
for your LA. This is a one-off process and does not require repeating for each mail merge. 

 

 

  

 

 

Some LA specific text is embedded within paragraphs of conditional text. This LA 
specific text cannot be edited directly. The conditional text code will required to be 
edited. Refer to Editing LA specific text embedded within conditional text on page 
25 
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To link the data file to the Microsoft Word template: 

1. Open the letter template. 

2. In the letter template, click the Mailings tab on the Microsoft Word ribbon. 

 

3. Most  of the commands on the Mailings tab will appeared greyed-out (unavailable) until a 
data file has been linked to the template. 
 
Click the Select Recipients command on the Mailings ribbon then select Use Existing 
List… from the dropdown menu. 

 

4. In the Select Data Source dialog box. 

a. Navigate to the downloaded test pupil data file. (PupilFeedback.csv). 

b. Click the file to select it. 

c. Click  
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When the data file is attached, the previously greyed-out commands on the Mailings tab are 
now available. 

 

5. To View the data in the letter template, on the Mailings tab: 

a. Click the Preview Results command. This will substitute the field names in 
the template, with the actual data. 

b. Use the navigation buttons on the Ribbon to scroll through the records. 
When scrolling, notice the conditional text changing for each BMI category. An 
example of each letter can be found here: Specimen results letters to parents. 

c. To show merge fields and conditional text with or without the grey 
background, click Highlight Merge Fields. 

….

 

6. The link is complete. 

  

Navigation Buttons 

https://www.gov.uk/government/uploads/system/uploads/attachment_data/file/371055/Result_letters.docx
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Editing LA specific information in static text 

There are 3 sections of static text in the template that require customising for your LA. 

1. Sender name, organisation address, postcode, sender phone number & email address. 
Modify these items, highlighted in yellow, so that they provide the relevant information for 
your LA. 

The yellow highlight should be removed: 

a. Select the text to remove highlight from 

b. Select the Home tab on the ribbon, click 
Text Highlight Colour. 

c. Click  No Colour 

 

 

Care should be taken not to change the layout or the position of the Parent/ Carer address 
on the left. 
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2. In the paragraph beginning ‘This information has not been shared with’, modify the text to 
reflect which organisation holds the measurement information (local NHS or local authority 
public health team), removing the yellow highlight. 

3. Modify the Sender Name. 

 

 

Add your LA’s emblem or logo. 
To add your LA’s emblem or logo in the Header area of the feedback letter template: 

1. Open the template’s Header. From the Insert tab on the Ribbon, click the Header 
command. 

2. From the bottom of the drop down menu, select Edit 
Header. The header area opens and the rest of the template 
is temporarily greyed-out. 

3. From the Design tab (Header & Footer tools) on the Ribbon, Click the Picture command. 

 

4. In the Insert Picture dialog box, navigate to the emblem or logo image to be inserted. 
Select the required image and click  
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5. To make the image more ‘maneuverable’, click the image to select it.  
 
From the Picture Tools, Format tab, click Wrap Text and select Square. 
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6. Drag the image to its required position ensuring that the layout or the position of the Parent/ 
Carer address information is not affected. 

The image can overlap the Header / Document body border. 

7. Click the Close Header and Footer command. 

 

Editing LA specific text embedded within conditional text 

Additional LA specific text is embedded within the conditional text in the letter template. There are 2 
important considerations when editing this text:  

• You cannot edit conditional text directly without first toggling to view the field code that 
generates this text. 

• As different conditional text is displayed for each BMI category, you will need to perform this 
process for each BMI category. This is done by viewing each of the 4 records within the 
linked test pupil data file, one for each BMI category. 
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To edit LA specific text within conditional text. 

1. Ensure that all mail merge fields and conditional text are easily identifiable by showing with a 
grey highlighted background: On the Mailings tab on the Ribbon,click Highlight Merge 
Fields. 

2. Ensure that Preview Results  is on (data is viewed instead of mail merge field names)  

3. Ensure you are viewing the first record in the test child data CSV file (PupilFeedback.csv). 

 

4. The first record is for an underweight pupil (Anna Barlow). Locate the paragraph beginning 
‘Many underweight children….’ We can identify this as being conditional text because of the 
grey highlight. 

5. Within this paragraph, the yellow highlighted text [phone number] should be replaced with 
the contact number for NCMP within your LA.  

6. To edit this text, you must toggle the conditional text to show the text’s field codes. Position 
the cursor anywhere within the conditional text and right click. 

7. From the shortcut menu, select Toggle Field Codes. 

 

8. Notice that the paragraph is encapsulated between curly brackets { } with additional codes 

that ensure that this text is displayed only when the child is in a specific BMI category. 
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9. Now that the merge codes are on show for this conditional text, the LA specific information 
can be modified. In this case, replace the text [phone number] with the contact number for 
NCMP in your LA. Delete the unrequired text including brackets [ ] and the yellow highlight. 

 

 

10. To close and update the conditional text, right click anywhere within the conditional text and 
from the shortcut menu, select Update Field.  

  

Mail Merge Code 

Mail Merge Code 

 

• If the LA specific text is modified without toggling the field codes, the 
newly entered text will not be saved. 

• Care must be taken not to modify any of the mail merge codes at the 
beginning or the end of the toggled conditional text 
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11. The conditional text is updated and is displayed normally without the mail merge codes 
 

 

12. This process needs to be repeated for each of the remaining 3 records in the linked test 
pupil data file. To move to the next record in the data file, click Next Record on the Mailings 
tab on the Ribbon. 

 

13. The next record (#2) is for a healthy weight pupil (Ian Dalby). Locate the paragraph 
beginning ‘To help your child remain healthy….’  

 

14. To edit this text, you must toggle the conditional text to show the text’s field codes. Position 
the cursor anywhere within the conditional text and right click. 

15. From the shortcut menu, select Toggle Field Codes. 

16. Again, the paragraph is encapsulated between curly brackets { } with additional codes. 



Generating Feedback Letters. 

 

28  Copyright © 2024, NHS England. All rights reserved.  
 

 

 

17. Now that the merge codes are on show for this conditional text, the LA specific information 
can be modified. In this case, select the location for additional health information, on the 
next page OR in an enclosed leaflet. Delete the obsolete text, including brackets and the 
yellow highlight. 

Care must be taken not to modify any of the mail merge codes 

18. To close and update the conditional text, right click anywhere within the conditional text and 
from the shortcut menu, select Update Field.   

 
 

19. To move to the next record in the data file, click Next Record on the Mailings tab on the 
Ribbon. 

  

Mail Merge Code 

Mail Merge Code 
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20. The next record (#3) is for an overweight pupil (Noel Smith). Locate the paragraph beginning 
‘If your child is overweight now….’  

21. Toggle the conditional text to show the text’s field codes by a Right Click within the 
paragraph.  

22. From the shortcut menu, select Toggle Field Codes. 

 

23. Make the changes to the LA specific text; 

a. Replace the text [phone number] with the contact number for NCMP in your LA. 

b. Select the location for additional health information, on the next page OR in an 
enclosed leaflet. 

c. Delete the obsolete text including brackets and the yellow highlight.  
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24. To close and update the conditional text, right click anywhere within the conditional text and 
from the shortcut menu, select Update Field.  

 

25. The conditional text is updated and is displayed normally without the mail merge codes. 

26. To move to the next record in the data file, click Next Record on the Mailings tab on the 
Ribbon. 

27. The last record (#4) is for a very overweight pupil (Sarah Samuels). Locate the paragraph 
beginning ‘Being very overweight….’  

28. Toggle the conditional text to show the text’s field codes by a Right Click within the 
paragraph.   
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29. From the shortcut menu, select Toggle Field Codes. 

 

30. Make the changes to the LA specific text; 

a. Replace the text [phone number] with the contact number for NCMP in your LA. 

b. Select the location for additional health information, on the next page OR in an 
enclosed leaflet. 

c. Delete the obsolete text including brackets and the yellow highlight.  

31. To close and update the conditional text, right click anywhere within the conditional text and 
from the shortcut menu, select Update Field. 

 

32. The conditional text is updated and is displayed normally without the mail merge codes  
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33. Now that the conditional text for each BMI category have been set up, save the template as 
normal.  

Once saved, the template is fully set up and can be used as required in the future without 
further modifications to the conditional text. 

Link your downloaded child data CSV file to the template 

To link your child data CSV data file (generated by the NCMP IT system) to the set up letter 
template instead of the test child data file: 

1. In the letter template, click the Mailings tab on the Microsoft Word ribbon 

 

2. Click the Select Recipients command on the Mailings ribbon then select Use Existing 
List… from the dropdown menu. 
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3. In the Select Data Source dialog box,  

a. Navigate to the downloaded pupil data file,  

b. Click the file to select it  

c. Click . 

  

4. To View the data in the template, on the Mailings tab: 

a. Click the Preview Results command. This will substitute the field names in 
the template, with the actual data. 

b. Use the navigation buttons on the Ribbon to scroll through the records. 

Print parental feedback letters 

There are two approaches to printing a mail merged document 

1. Send the mail merge output directly to the printer with no further editing. 

2. Send the mail merge output to a new Word document, each letter is on a separate page. 
This approach will offer you the flexibility to edit feedback letters for specific parents, for 
example, adding a note. 
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To mail merge directly to a printer 

1. From the Mailings tab of the Ribbon, click the Finish & Merge command. 

2. Select Print Documents… from the drop down menu. 

 

3. Select which letters to print: 

a.  All feedback letters. 

b. Just the Current record displayed on the screen. 

c. A range of records by entering start & end record ID. 

 

 

4. Click .  

5. Select the required printer if different from your default printer. 

 

6. Click .  

Letters will begin printing.   

1 

2 

 

 

Before sending any letters, please reassure yourself that all letters are correct. 
You may want to manually check a sample of letters produced to ensure no 
issues have occurred during the mail merge process. 
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Please note that if you attempt to print the document using normal methods, such as the 
print icon on the Quick Access Toolbar, Print from the File (Backstage View) or Ctrl+P, 
only the current record on view will be sent to the printer. 

 

To mail merge to a new word document 

1. From the Mailings tab of the Ribbon, click the Finish & Merge command. 

2. Select Edit Individual documents… from the drop down menu. 

 

3. Select to print: 

a.  All feedback letters. 

b. Just the Current record displayed. 

c. A range of records by entering start & end record ID. 

4. Click .  

5. Select the required printer if different from your default printer. 

 

6. Click .  

7. A new multi-page document opens containing all the parent feedback letters. 

8. If any specific comments are required to be added to individual letters, located the letter and 
type in comments. 

 

 

 

 

 

1 

2 
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Inserting text based on multiple conditions 

 

The IF…THEN…ELSE rule is used in mail merge to choose text depending on two defined 
conditions.  

 

To choose text based on more than two conditions this rule needs to be nested.  

 

The guidance below shows how to choose text based on four conditions (i.e. four different 
paragraphs based on the four different BMI classifications). 

 

1. Create the first IF…THEN…ELSE rule 

 

 

Select OK and field coding will be displayed ([Alt]+F9 if not displayed); 

 

This means that if ClinicalBMICategory=underweight then UNDERWEIGHT TEXT will be 
displayed, otherwise nothing will be displayed as shown by the “” at the end of the expression. So, 
currently, the rule only has two conditions: underweight or not underweight. 

To nest this rule, put the cursor between the “”: 

 

Then repeat the above steps: Rules > If…Then…Else… 
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Nest again: 

 

 

 

 

 

And again: 
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This rule should now display the four different paragraphs based on the four different BMI 
classifications 
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Appendix A – Supplementary information for feedback letter 
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